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About Web Ambassador 

About Web Ambassador 
The Web Ambassador is a software program that enables you to access patient 
exams via the Internet. 

Before you start 
Before you start using Web Ambassador, review these tips: 

 About the Web Ambassador workspace 

 About receiving exams automatically 

 Tips for viewing exams 

Features 
Using Web Ambassador, you can: 

 Search for your patient.  In the Search box, type the patient's last name, 
or the first letters of the name.  Carefully read any warnings. 

 View images.  View the images for a selected exam. 

 View a report.  View the completed report for the selected exam. 
Note: Viewing reports is an optional feature.  To use this feature, the 
facility’s Communicator web server must be configured for report 
viewing. 

 Listen to a recorded audio summary.  Listen to an audio conclusion 
recorded by the reading physician. 

 View exam notes.  View text notes and listen to audio notes about the 
exam 

For details on requirements for your PC to use Web Ambassador, check the 
System Requirements. 

About the Web Ambassador Workspace 
When you log into Web Ambassador, you'll see the following tabs: 

 The Web site tab.  Provides an easy way to access the facility's web site. 

 The Exam Server tab.  Lists exams that you have access to view. 
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The Web Site tab 
This is the general web site for the facility. 

To view the facility's web site: 

1. Click the Web Site tab. 

 

The Exam Server tab 
This is the tab that lists all exams that you have permission to access. 

To view the list of exams: 

1. Click the Exam Server tab. 
 
The Exam Server tab displays a list of exams. 
 

 
The Exam Server tab 

 
  

Note:  The Toolbar also includes a Report icon  if the facility's 
Communicator web server is configured for report viewing. 

Menu Bar

Toolbar

Database

Exam Server tab

Exams that you have viewed

Exam list 

Search field 

Table headings 
(click to sort) 

Search all checkbox 
(for patients who are in your care, 
but were not referred by you) 

Title Bar 
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From this window, you can: 
 View exam images. 
 View exam report. 
 View exam properties. 
 Play a recorded audio conclusion. 
 Copy the exam. 
 View or listen to exam notes. 

 

System Requirements 

Web Ambassador Requirements 

Recommended Components 
Before installing Web Ambassador, ensure that your system meets or exceeds the 
following requirements. 

 
Processor and speed Pentium class processor 1.0 GHz or higher 

RAM 512 MB (minimum) 

Operating system Microsoft® Windows XP 
OR Microsoft Windows 2000 with Service Pack 4 or higher 

Internet browser Internet Explorer 6 or higher 

Hard disk space At least 5 GB available of hard disk space for program files and to 
copy exams to the computer’s local drive. 

Monitor Video display resolution of at least 1024 x 768 with 256 colors. 
 
Note: 15 and 16-bit color modes are not recommended since they 
do not provide for the display of 256 shades of gray.  24-bit and 
32-bit color modes provide for 256 shades of gray and excellent 
color display, but may have some impact on graphics 
performance for larger images. 

Sound card Required for playback of audio conclusion. 

Note:   With many Windows based applications, performance may increase with 
additional RAM and processor speed.  Contact your system administrator to 
determine if your computer will get increased performance from upgrading these 
items. 

ISP Requirements 
The system requires a connection to an Internet Service Provider (ISP) or a direct 
dial up connection (if your Communicator is so equipped).  Your connection 
through an ISP may also use Virtual Private Networking (VPN).  Consult your 
system administrator for details. 
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Supported ISP connections include the following: 

 Modem dial-up 

 DSL 

 Cable Modem 

 SDN 

 T1 

 Frame Relay 

Internet Browser option 
You can also view exam images on a Communicator web site without installing 
Web Ambassador, by accessing the web site using only a web browser. 

Note: The Web Ambassador offers many image display options not available 
using only a standard web browser. 

 

Installing the Program 

Installing Web Ambassador 
To install Web Ambassador:  

1. Ask the facility administrator for the web site where you can download Web 
Ambassador. 

2. Type the address for the Web Ambassador download page  

3. At the DR Systems Web Download page, click the appropriate download 
link. 

4. At the File Download page, click Open. 

5. Follow the prompts to complete the download. 
The Web Ambassador setup program guides you through the installation 
process. 

Updating Web Ambassador 
Each time you use Web Ambassador, the system checks to be sure you have the 
most current version.  If a newer version is available, the system prompts you to 
download the new version. 

1. Start Web Ambassador. 
If you don't have the most current version of the program, the systems asks if 
you want to update your program to the latest version. 

2. Log in. 
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3. Click Yes. 
The system reminds you that you'll need to log in again, and that the 
application will be closed. 

4. Click OK to continue. 

5. Enter your user name and password. 

6. At the DR Systems Web Download page, click the appropriate download 
link. 

7. At the File Download page, click Open. 

8. Follow the prompts to complete the download. 
The Web Ambassador setup program guides you through the installation 
process. 

Setting Options 

Receiving Exams Automatically via the Internet 
 About automatic receiving 

 Setting receive options 

 Disabling standby or hibernation mode 

About automatic receiving 

What programs can receive exams automatically 

Web Dominator and Web Ambassador users can receive exams automatically. 

Why receive exams automatically? 

By receiving exams automatically, you can reduce the time waiting for an exam 
to download over an Internet connection. 

What can you specify? 

When you automatically receive exams, you can specify: 

 The exam components. 

 The exam modality. 

 The exam status (such as unread) and priority (such as STAT or ASAP). 

 The type of notification, if any.  The system can play a sound or run a 
program. 
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Setting receive options 
1. On the Receive menu, click Receive Options. 

 
The Exam Receive Options dialog box opens. 
 

 
2. Complete the fields in the Exam Receive Options dialog box.  Select: 

 How frequently you want to receive exams automatically. 

 The components you want to receive.  For example, select images and 
montages, or all components. 

 The criteria for receiving the exams.  For example, select the modality, 
exam status, and exam priority. 

 Any actions you want to take after receiving exams.  For example, you 
can play a specific sound to indicate that exams have arrived. 
 
For details, see Exam Receive Options dialog box in Chapter 8, 
Reference. 

Disabling Standby or Hibernation mode 
To receive exams automatically: 

 Your computer must be powered on. 

 Web Dominator must be open. 

 The computer must not be in standby or hibernation mode. 

To disable hibernation and standby mode: 

1. Click Start, point to Settings, and click Control Panel. 

2. Double-click Power Options.  Change System Standby and System 
Hibernates to Never. 
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Adding an Additional Data Source 
You can add an additional data source if you need to connect to multiple 
facilities. 

Note:  Before you start, ask the system administrator at the facility for the Web 
site address. 

To add an additional data source: 

1. Double-click the Web Ambassador icon . 

2. Add the facility as a data source. 
From the File menu, click Add Web Site Data Source. 

3. The following dialog box opens: 
 

 
  

4. Enter the web site address. 

5. Click Go. 
 
The Logon dialog opens. 
 

 
  

6. Log on.  Enter your User Name and Password. 
The system prompts you to add the data source. 

7. Click Yes. 
The system prompts you to save the data source. 

8. Click Yes. 

About Deleting Exams from the Local Exam Cache 

What is a cache? 
A cache is a directory on the computer's hard drive where the system stores 
exams that have been accessed over the Internet or a network.  By storing exams 
on a local drive, the system can quickly display images, rather than trying to 
access them over a slow network connection. 

Why delete exams from the cache? 
Stored exams can be very large, and can significantly reduce the available disk 
space on your PC.  By clearing the cache, you can regain disk space. 
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What programs use exam cache directories? 
Web Ambassador, Web Dominator, and WAN Dominator use exam cache 
directories. 

When are exams copied to the cache? 
Exams are copied to the cache during the following activities: 

 Automatically receiving an exam. 

 Copying an exam. 

 Viewing an exam 

 Adding an exam to a Worklist (Web Dominator only). 

Where and when are exams purged? 
Exams are purged only: 

 From a local drive. 

 From cache directories. 

 When the exams meet purge criteria that you set. 

Deleting Exams from the Local Exam Cache 
 You can set options to have the system automatically delete files 

("purge" them) from the local exam cache. 
 You can also delete files manually from the local exam cache. 

Setting options to have the system automatically delete files 
1. From the File menu, click Delete Local Exam Properties. 

The Delete Local Exam Properties dialog box opens. 

2. Type the number of days that you want to retain exams in the cache after you 
last accessed them. 

3. Select the Enable automatic purging of cached exams checkbox to allow 
the system to purge exams automatically from the cache. 

4. Click the Save Setting button to save the settings, and close the dialog box. 

Deleting files manually from the local exam cache 
1. From the File menu, click Delete Local Exam Properties. 

The Delete Local Exam Properties dialog box opens. 

2. Type the number of days that you want to retain exams in the cache after you 
last accessed them. 

3. Select the Purge Now checkbox to delete exams from the cache that meet the 
criteria you set above. 
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Starting the Program 

Starting Web Ambassador 

1. Double-click the Web Ambassador icon . 

2. Select the facility or other location that contains the exams you want to view. 
In the Database list, click the drop-down arrow and select the database. 
 

 
 
Note: If you select CD-ROM Exam Files and insert a second CD, select the 
Reset button to list the exam files on the current CD. 

3. Enter your user name and password to log in. 
 

 
  

Searching for Exams in Web Ambassador 
To retrieve an exam for viewing: 

1. Start Web Ambassador. 

2. Click the Exam Server tab. 
 

 
 
Note:  When you first view the Exam Server tab, no exams are in the list. 
 You need to type a name in the Search box to see entries in the list. 

3. Search for the patient. 
In the Search box, type the patient’s last name, or the first letters of the last 
name.  Carefully read any warnings. 
 
Tip: To search for all patients, including patients where you are not listed as 
a referring physician, , click Search All. 
 

 
 
If the checkbox is not visible, you do not have permission to view exams for 
patients where you are not the referring physician. 
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Logging in and out 

Setting and Changing Passwords 

About setting or changing your password 
You can change your password: 

 When the system prompts you to change your password. 

 As needed. 
 
Note: To change your password, your user account must allow changing 
passwords. If you cannot change your password, the Set Password 
button is unavailable and you cannot change your password. 

Changing your password when prompted 
To change your password when the system requires it: 

1. Log in to DR Systems PACS. For details on logging in, see "Logging in." 
 
The system displays a message requiring you to change your password. 
 

 
  

2. Click OK. 
 
The Set User Password dialog box opens. 
 

 
  

3. Complete the Set User Password dialog box: 

 Old Password. Type the current password. 

 New Password. Type the new password.  

 Confirm New Password. 
 
If your new password doesn't meet the requirements set by your system 
administrator, the system displays an error message. The message 
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prompts you to check the requirements for password length, complexity, 
and history. 
 
Click OK for the message and type a revised password in the New 
Password box and the Confirm Password box. 

4. Click OK. 
 
A confirmation message opens. 
 

 
  

5. Click OK at the message that the password changed for the user. 
 
You are returned to the DR Systems User Login window.  
 

 
6. In the Password box, select the old password entirely. Type your new 

password over the old password. 

7. Click Login. 
 
Dominator opens to the tab set for the workstation. 

Changing your password as required 
To change your password: 

1. Log in to Dominator. For details on logging in, see "Logging in." 

2. From the File menu, select Set Password. 
 
The Set User Password dialog box opens. 
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3. Complete the process for changing your password. For details, see 
"Changing your password when prompted." 

Login Errors 
Depending on the processes established by your system administrator, you could 
see the following error messages.  

 Password incorrect. If you type the password incorrectly, the system 
displays the following message: 
 

 
 
Click OK and retype the password. 

Note: If your system is configured to allow a specific number of attempts to log 
in, and you exceed that number, you can be locked out. Contact your system 
administrator. 

 Account expired. If the date passed that your account was set to expire, 
the system displays the following message: 
 

 
 
Click OK and contact your system administrator. 

 Account disabled. If your account was disabled by your system 
administrator, the system displays the following message: 
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Click OK and contact your system administrator. 

 No user account. If you type a user name in the Login ID box that is not 
in the system, the system displays the following message: 
 

 
 
Click OK and retype the Login ID. 

Logging Out 
To log out of DR Systems PACS: 

1. Click the Logout button  on the tool bar.  
 
The User Login opens. 
 

 
 
Typically, you leave the User Login dialog box open for the next user to log 
in.  

2. If you need to shut down the application, click Exit. 

Getting Help in Web Ambassador 
To get help, you can click Getting Started or Help on the menu bar. 

The Getting Started menu 
 Click the Getting Started menu for a quick overview of standard 

procedures. 
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The Getting Started instructions open: 
 

 

The Help menu 
 Click Help Topics in the Help menu for detailed step-by-step 

instructions. 
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Listing Exams for Viewing 
To retrieve an exam for viewing: 

1. Start Web Ambassador. 

2. Click the Exam Server tab. 
 

 
 
Note:  When you first view the Exam Server tab, no exams are in the list. 
You need to type a name in the Search box to see entries in the list. 

3. Search for the patient. 
In the Search box, type the patient’s last name, or the first letters of the last 
name. Carefully read any warnings. 
 

 
 
 
Tip: To search for all patients, including patients where you are not listed as 
a referring physician, click Search All. 
 

 
 
If the check box is not visible, you do not have permission to view exams for 
patients where you are not the referring physician. 

About the Exam List in Web Ambassador 

Number of exams displayed 
In Web Ambassador, the system restricts the exam list to displaying 250 exams at 
one time.  This goal of this restriction is to improve performance over an Internet 
connection. 

Note:  The 250 exam number is a default.  Your facility may change the number 
of exams to be displayed.  
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When the exam list is updated 
The exam list is updated each time you search. 

Note:  When you sort, the current 250 exams in the exam list are sorted.  The 
order is changed, but the list contains the same set of exams. 

Searching and Sorting in Web Ambassador 
You can search for a patient's name, a patient's ID, and many other parameters. 
 You can search by: 

 Sorting on a column. 

 Using the Search box. 

You can also start a new search by: 

 Clearing the Search box. 

Sorting on a column 
To sort a column: 

1. Click the column heading (such as Patient ID) that you want to sort by. 
 
The system displays the list sorted by your selection. 
 
An arrow indicates the sort order: 

 Down arrow:  Ascending order (from first to last): 

 
 Up arrow: Descending order (from last to first) 

 
2. To switch the order, click on the column heading again. 

OR Right-click the column to select sort options from the shortcut menu. 

Searching by using the Search box 
To search by using the Search box: 

1. In the Search box, enter the patient’s last name or Patient ID number. 
Tip:  You can enter part or all of the patient's name.  Type the last name first, 
and use a comma (,) to separate the last and first name.  For example, you 
can enter SMI or SMITH or SMI,B or SMITH,B or SMITH,BOB. 
 
The system displays the records that match the search. 
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Clearing the Search box 
To clear the search: 

1. Click Reset. 
OR Click Alt+R. 

2. Start another search if required. 

Viewing Exams in Web Ambassador 
To view an exam in Web Ambassador:  

1. On the Exam Server tab, select an exam. 

2. Click the View button . 
 
Note: You can also double-click the exam, or right-click to view it. 
 
The system displays the first image in the exam. 
 

 
 
Note:  If a montage exists, it is the first image in the left pane. 
  

3. Select an action from the toolbar: 

  to view exam properties. 

  to compare this exam with a previous exam for the same 
patient. 

  to listen to a recorded audio conclusion. 

  to copy the exam. 

4. Use the tools on the View Exam toolbar as required. 
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5. When finished, click one of the following buttons to return to the Exam 
Server window: 

 . 
 
OR 

 . 

Viewing Exams on a USB Flash Drive 
To view exams on a USB flash drive: 

1. Insert the USB flash drive into an available USB port.  
 
If the system displays a dialog box indicating that the operating system 
detected the new device and requires specific drivers, load any required 
drivers to access the device as a removable drive.  
 
Wait 10-15 seconds before attempting to use a newly inserted drive. 

2. Select the USB flash drive from the Datasource list. 
 
The system displays the newly inserted drive with a designation such as: 
 
G:\Removable Drive. 

3. Select the exam you want to view. 

Tips for Viewing Exams 
The following are basic tips for viewing exams. 

 

To: Do this: 

Scroll 
through 
images: 

Click (the left mouse button) and move the mouse up or down. 
OR  
Press the Up arrow or Down arrow. 

Change 
between 
series: 

Press Page Up or Page Down. 

Specify the 
number of 
images 
displayed at 
once: 

Press 1 to display one image. 
Press 2, 3, 4, 6, 8, 9 to display that number of images. 
Press 0 to display 10 images. 
Press - to display 20 images. 
Press = to display 24 images. 

Compare 
exams. 

Click Compare to display a previous exam for the same patient. 
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Note: For detailed instructions, see "Viewing Exams in Web Ambassador." 

 

Marking Exams as Reviewed in Web Ambassador 
 About marking exams as reviewed 

 Marking the exam as reviewed after viewing images 

 Marking the exam as reviewed from the Exam Server tab 

About marking exams as reviewed 
After you finish viewing an exam, you can mark it as reviewed.  At a glance, you 
can see which exams you still need to review. 

Example of exam marked as reviewed: 

 

Marking the exam as reviewed after viewing images 
To mark an exam as reviewed after viewing images: 

1. View the exam. 

2. When finished, click Done. 
The system asks if you want to mark the exam as reviewed. 

3. Click Yes. 

Marking the exam as reviewed from the Exam Server tab 
To mark an exam as reviewed: 

1. Select an exam in the Exam Server tab. 

2. Do one of the following: 

 Right-click the exam, and click Mark as Reviewed in the shortcut menu. 
OR 

 Select the exam, and click Mark as Reviewed from the Task menu. 

Clearing the Reviewed Mark from an Exam 
To clear the reviewed mark from an exam: 

1. Select the exam. 

2. Click Mark as Not Reviewed from the Task menu. 
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About the Electronic Requisition 
The Electronic Requisition contains a summary of the patient's history. 

 

Electronic Requisition title bar 
The title bar of the Electronic Requisition summarizes the data about the exam. 
 

 
  

Electronic Requisition opens for comparison exams 
If you set a viewing preference to automatically load comparison exams, the 
Electronic Requisition is displayed regardless of your preference setting for 
"Hide Req after Comparison exam selection." For details on setting viewing 
preferences, see "Setting Preferences for Reading Physicians. 

Viewing Exam Properties 
To view exam properties: 

1. Select an exam. 

2. Click the Properties button . 
 
The Properties dialog box displays: 
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3. When finished viewing properties, click Close. 

Selecting Viewing Modes and Options 

Displaying a Series Per Square  
Series per Square displays a series in each window square. The number of 
squares shown on a screen can be changed through the View Menu. The Page 
function is active in this mode, allowing you to scroll through each series.  

To set Series per Square display:  

1. Click the Series per Square button . 
 
OR  
 
From the View Menu, select Panel Properties. Change the layout method to 
Series per Square.  

Displaying One Image in Each Square 

About Image per Square mode 
Image per Square displays each image in a series in a viewing window. 
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You can change the number of squares shown on a screen through the View 
Menu. The Mag Box function is active in this mode. To move the images on the 
screen through the panels, use the Scroll function. 

Viewing an image per square 
To view an image per square: 

1. On the toolbar, click the Image per Square button . 
 
OR  
 
From the View Menu, select Panel Properties. Change the layout method to 
Image per Square.  

Note: In Image per Square display mode, there are additional viewing functions 
on the toolbar. 
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About Viewing and Editing Tools 
You can use a variety of tools to view and edit exam images. 

The ability to save edits to images depends on user rights: 

 Ability to save.  Typically, technologists and reading physicians can 
save edits to images. 

 Ability to view only.  Other users, including referring physicians, can 
use the following tools.  However, they cannot save an edited image. 

 
 

Tool / action Topics 

3-D image processing: Image processing (Voxar) 

Annotating images: Adding Arrow Annotation 
Adding Measurement Annotation 
Adding a Region of Interest 
Adding Text Annotation 

Cardiology tools: Calibration (new in Release 7) 
Cine - playing images continuously 
Poly line measurement (new in Release 7) 
Stenosis measurement (new in Release 7) 
Image Subtraction Masks (new in Release 7) 

Comparing images: Flipping between Images for Comparison (new in Release 7) 
Position-linked Scrolling for Comparison 
Shuffling Images for Comparison (new in Release 7) 
Targeting Areas for Comparison 

Cropping: Cropping images 

Image processing: Using Image Processing to enhance contrast 

Interpolation: Controlling Image Interpolation for Display 
Controlling Image Interpolation for Printing 
Using Bilinear Interpolation and Pixel Replication 

Inverting, rotating, and 
flipping images: 

Inverting an image 
Rotating and Flipping an Image 

Magnifying images: Magnifying Images 
Magnifying a Portion of the Image 
Magnifying Portions of Adjacent Images Simultaneously 

Tracking viewed areas: Pixel tracking (new in Release 7) - useful tool for mammography 

Roaming: Roaming 
Roaming Adjacent Images Simultaneously (new in Release 7) 
Applying Roaming to all Images in Series 

Scout insets: Plotting with scout insets 

Series: Selecting a Series to Display 
Selecting and Dropping a Series 
Specifying an Image in a Series to View 
Simultaneously Paging Through Series Across Monitors 
Viewing a series 
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Tool / action Topics 

Scrolling images: Scrolling Images 

Window/level: Adjusting the window/level 

 

Advanced Image Processing 

About Advanced Image Processing using Voxar 3D 
Advanced image processing using Voxar 3D™ is an option available from DR 
Systems.  Voxar provides visualization and analysis tools to improve your 
workflow and increase your productivity, with the increased demands of 
interpreting MDCT, multi-channel MRI and PET studies. 

Note:  For details on using Voxar 3D, see Voxar's Online Help. 

Workstations where available 
Voxar 3D™ advanced image processing is available on the following 
workstations: 

 Dominator reading physician workstation. 

 Web Dominator reading physician workstation. 
Note:  Web Dominator users can use Voxar locally, but cannot save 
Voxar-generated images to the server. 

 Advanced Windows Catapult, the technologist's QA workstation. 

Imaging processing features 
Advanced image processing, traditionally performed on scanner consoles, 
includes the following features: 

 3D modeling reconstruction. 

 Color shading. 

 MPRs and MIPs. 

 Curved rendering. 

 Volume rendering. 

 Volume measurement. 

 Surface shading. 

 Tissue segmentation. 

 A VesselMetrix module to measure vessels in CTA and MRA images. 
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Other features 
Other features include: 

 On Windows XP workstations, you can display text and cross-hairs using 
green lines. 

 Images generated by Voxar can be used as insets. 

 Ability to apply insets to series generated by Voxar. 

 Support for concurrent licensing, which provides an option to have 
concurrent, rather than licenses per workstation. 

 Voxar start automatically with the MPR screen. 

 Controls for selecting view modes. 

Annotating images 

Adding an Arrow Annotation  
 Placing an arrow on an image. 

 Moving an arrow annotation. 

 Changing the size of an arrow annotation. 

 Changing the direction of the arrow annotation. 

Placing an arrow on an image 
To place an arrow on an image: 

1. Click the Arrow Annotation button . 

2. Click on the image to place the arrow. 
OR Right-click to place a labeled arrow. 

Moving an arrow annotation 
To move an arrow annotation: 

1. Click the arrow. 

2. Hold and drag the arrow to the new location. 

Changing the size of an arrow annotation 
To change the size of an arrow annotation: 

1. Click the arrow. 

2. Click on the box at either end of the arrow and drag to the new location. 
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Changing the direction of the arrow annotation 
To change the direction of the arrow annotation: 

1. Right-click the image. 

2. Select Up, Down, Right, or Left from the shortcut menu. 

3. Click the image to place the arrow. 

Adding Text Annotation 
 Placing text on an image. 

 Moving a text annotation. 

 Copying text annotation. 

Placing text on an image 
To place text on an image: 

1. Click the Text Annotation button . 

2. Right-click the image.  

3. Select a phrase from the shortcut menu. 
OR Click Edit to type text. 

4. Click the image to place the text.  

Moving a text annotation 
To move a text annotation: 

1. Click the text.  

2. Click the shaded line and drag to move the text.  

Copying text annotation 
To copy a text annotation: 

1. Right-click the text.  

2. Select Copy from the shortcut menu. 

3. Click to place text.  

Adding a Measurement Annotation  
 About measurements 

 Adding a measurement type 

 Deleting measurements 
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About measurements 

Types of measurements 

You can add the following measurements to images: 

 Line measurement. Measures the straight line distance between two 
points. Line is the default measurement. 

 Poly line measurement. Measures the distance between two points along 
multiple line segments, for example, the curved segment of a vessel.  

 3-point angle measurement. Measures the angle between the X axis and 
the Y axis of three designated points. 

 Cobb angle measurement. Measures the angle between two designated 
line segments that cross a bone or vessel, for example when measuring 
the degree of scoliosis.  

 Stenosis measurement. Measures the ratio of the diameter of a normal 
segment of a vessel and a constricted segment of a vessel. 

Images must be calibrated 

The image must be calibrated to use the measurement tools. For details on how to 
calibrate the image, see "Calibrating an Image." 

Note: If you calibrate an image, your calibration is not saved with the exam. Any 
measurement annotations are saved with the exam, but cannot be modified. They 
can, however, be deleted. 

Accessing the measurement menu 

To add a measurement, access the measurement menu: 

1. Click the Measurement Annotation button . 

2. Right-click on an image panel. 
 
The shortcut menu opens. 
 

 
3. Select the measurement you want to add. 

Adding a line measurement 
To place a measurement rule on an image:  

1. Access the measurement menu. For details, see "Accessing the measurement 
menu." 

2. Click the image at the starting location.  

3. Drag the line to the ending location and release the mouse button.  
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The system displays a line showing the starting point and the ending point 
and the line measurement. 
 

 
  

Adding a poly line measurement 
To add a poly line measurement: 

1. Access the measurement menu. For details, see "Accessing the measurement 
menu." 

2. Select Poly Line. 

The cursor changes to the angle symbol . 

3. Click and hold the left mouse button where you want to start the poly line 
measurement, drag to the next point, click and release the mouse button, 
move to the next point and click. Continue clicking points, releasing,  and 
moving the mouse to capture the distance you want to measure. 
 
The system traces the line between each point. 

4. Double-click at the end point. 
 
The system stops tracing lines and inserts the measurement. 
 

 
 
Tip: To adjust the poly line measurement, select it and move the handles to 
the preferred location. 
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Adding a 3-point angle measurement 
To measure an angle: 

1. Access the measurement menu. For details, see "Accessing the measurement 
menu." 

2. Select 3-pt Angle. 
 

The cursor changes to the 3 point angle symbol. . 

3. At the starting point of the angle segment, click and hold the left mouse 
button and drag to the center point of the angle.  

4. Release the mouse button. 

5. Move the cursor to the end of the angle segment and click. 
 
The system inserts the degree of the angle. 
 

 

Adding a Cobb angle measurement 
To measure a Cobb angle: 

1. Access the measurement menu. For details, see "Accessing the measurement 
menu." 

2. Select Cobb Angle. 

The cursor changes to the  angle symbol . 

3. Click the cursor on the starting point and drag. Release the cursor. 

4. Repeat the previous step to add a second line. 
 
The system measures the Cobb angle between the two points. 
 

 

Adding a stenosis measurement 
The stenosis measurement estimates how much smaller a restricted vessel is 
compared to the normal vessel. 

To measure the percent stenosis of a vessel: 

1. Access the measurement menu. For details, see "Accessing the measurement 
menu." 

2. Select Stenosis. 
 

The cursor changes to the stenosis symbol . 
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Caution: A stenosis measurement is an estimate. The system estimates the 
stenosis measurement by the width of a vessel from the available, 2-
dimensional perspective. Another perspective may appear wider or narrower. 

3. At the reference segment, click and hold the left mouse button on one edge of 
the vessel and drag to the opposite edge of the vessel. Release the mouse 
button. 
 

 
4. Move the cursor to the cursor to the area where you want to measure the 

stenosis. Click and hold the left mouse button on one edge of the vessel and 
drag to the opposite edge of the vessel. Release the mouse button. 
 

 
5. The system displays the diameter at two points and the ratio of the diameter 

of a normal segment of a vessel and a constricted segment of a vessel, the 
percent stenosis. 

Deleting measurements 
To delete a measurement: 

1. Select a line segment. The system adds handles to the line segments.  

2. Right-click and click the Delete button. 
 

 

Adding a Region of Interest Annotation  
To outline an area on an image:  

1. Click the Region of Interest button . 

2. Right-click the image.  

3. Select a shape or free draw.  

4. Click and drag on the image to draw. 
 
The Average pixel value and standard deviation will appear for the outline. A 
warning is displayed if the values are not in Hansfield units.  
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Deleting Annotations  
To delete an annotation:  

1. Click the annotation.  

2. Press Delete.  

Calibrating 

Calibrating Images 

About Image Calibration 
Calibrating an image is necessary for video captured images from non-DICOM 
devices. Proper calibration is necessary for more precise measurements. 

You can apply either of the following calibration types: 

 Standard  
 
The Standard calibration tool allows you to generate a reference marker 
of a specified size, such as 5 mm, to estimate distance and for the system 
to measure more accurately. 

 Catheter 
 
The Catheter calibration tool allows you to specify the catheter size and 
identify a catheter in an image. 

How the system detects the catheter edges 

As you draw a short line down the center of the catheter, the system draws a 
bisecting line and scans the image pixels along the bisecting line to find the two 
points of greatest intensity change. The system uses these two points as the edges 
of the catheter. 

Calibrating an Image 
To place a reference marker on the image: 

1. Click the Calibrate Image button . 

2. Click the image.  
 
The Calibrate Image Size dialog box opens. 
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3. Complete the fields in Calibrate Image Size depending on the calibration 
you want. 

4. Select the Calibration type:  

 To calibrate an image that includes a marker of known size, select 
Standard.  

 To calibrate an image that has a catheter, select Catheter. 

Standard calibration 

If you selected Standard for the Calibration type, continue with these steps: 

1. Select the Marker Size and Marker Orientation, and click OK.  

2. Click the image at the starting location of the marker.  

3. Drag to the ending location of the marker and release the mouse button.  
 
The system displays the calibration reference marker. 
 

 

Catheter calibration 

If you selected Catheter for the Calibration type, the system makes the Marker 
Size and Marker Orientation unavailable. Continue with these steps: 

1. Click OK. 
 
The Calibrate Image Size dialog box closes. 

2. Click the cursor in the center of the catheter and release. 

3. Drag the cursor along the center of the catheter. 
 
Note: It is not necessary to hold down the mouse button while dragging. 
 
Drag the cursor as far as necessary for the perpendicular-bisector to intersect 
both sides of the vessel. 
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Note: The calibration should be performed in an area of the image where the 
catheter is the most prominent feature. Avoid allowing the perpendicular 
bisector to intersect with objects on the image other than the catheter. 
 

 
4. Click again to end the line. 

 
The system uses this information to detect the edges of the catheter. 
 
The Edge Detection Calibration dialog box opens. 
 

 
  

5. In the Catheter size (mm) box, specify the catheter size.  

6. Verify the proper detection of the catheter edges. 
 
If needed: 

 Adjust zoom factor. To verify the accuracy of the catheter edge 
detection, increase or decrease the Zoom factor by clicking the up arrow 
or down arrow respectively. 
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 Adjust the lines. Click the bisector to select it. Select one of the vertical 
handles and drag for better positioning. The system attempts to detect the 
catheter edges each time you move the lines. 
 

 
  

 Adjust Window level or width. To enhance viewing,  adjust the 
Window level or Window width. 

7. Click OK. 
 
The system draws a 5 mm vertical reference marker to scale. 
 
Caution: The system measures the width of a catheter from the available, 
two-dimensional perspective. This measurement is an estimate. 

Comparing exams 

About Targeting Areas for Comparison 
You can compare a selected anatomical area of an exam in one series to the same 
area in other series. Selecting the area with the 3D Cursor searches for that area 
in all displayed comparison series and targets the same area. 

 
About the 3D Cursor tool: 

 Supported workstations. Available on the Universal Manager for 
Dominator, Ambassador, and Web Ambassador. 

 Display mode. Requires that you set the display mode for the panel to 
Series-per-Square. 

 DICOM UIDs. Searches through all displayed series with the same 
DICOM Frame of Reference UID and targets the area with the cross-hair 
symbol in all displayed series.  

 Temporary features. Targets are temporary. They remain active for the 
current session. Closing a series clears the 3D Cursor targets. 

 One set at a time. Displays only one set of 3D Cursor targets at a time. 
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For example, if two exams are displayed, only one exam shows 3D 
Cursor targets at any given time. If you use 3D Cursor targets on one 
exam and then another, the 3D Cursor targets are cleared from the first 
exam. 

 Viewed, not printed. The 3D Cursor targets are only for viewing and do 
not appear on printed exams or on montages. 

 On all affected panels. The 3D Cursor targets appear on related images 
for all affected panels. If you move a targeted image to another panel, the 
target remains with the image. 

 Multiple copies. The 3D Cursor targets appear on multiple copies of the 
same image. 

 Tolerance. The tolerance for matching target areas with the 3D Cursor is 
+ or - 5 mm from the center of the selected target area. 

Targeting Areas for Comparison 
Use the 3D Cursor tool to target a specific anatomical area of an exam in the 
primary series and the same area in all displayed series. See the following topics: 

 Targeting specific areas of an exam by using the 3D Cursor tool. 

 Clearing target highlights. 

 Using other tools with 3D Cursor targets. 

Targeting specific areas of an exam 
To target an area of an exam for comparing images in series: 

1. View an exam in Universal Manager. 

2. Set the display mode to Series per Square Mode. 

 Press the Z key on the keyboard. 
 
OR 

 On the View menu, click Layout Images and select Series-per-Square 
Mode. 

3. Click the 3D Cursor tool  on the View Exam toolbar. 

The cursor changes to the 3D Cursor .  

4. Select the target area for comparison by clicking the top, left mouse button. 

Caution: Because the 3D Cursor target area could obscure an important part of 
the associated images, place it carefully on the image. 

Clearing 3D Cursor targets 
At any time while viewing exams, you can clear 3D Cursor targets from the 
exam images. Clearing the 3D Cursor targets does not clear associated 
annotations such as text or arrows. 
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To clear 3D Cursor targets from the exam: 

1. Put the cursor on the image while the 3D Cursor tool is active. 

2. Click the right mouse button. 

Using other tools with the 3D Cursor 
Targeting areas of an image by using the 3D Cursor works with the arrow, text, 
and magnify tools within the targeted area. 

Arrows 

If you use an arrow annotation within the 3D Cursor target area, the system adds 
the arrow to all images that contain the 3D Cursor target area. The location of the 
arrow on all images is the center of the target area. The positioning of arrows is 
not relative to the position of the patient.  

 

Text annotation 

If you use text annotation within the boundaries of a 3D Cursor target area, the 
system adds the text to all images that contain the 3D Cursor target area. The 
location of the top-left corner of the text on other images is the same distance 
from the center of the target area. The positioning of the text is not relative to the 
position of the patient. 

 

Magnify 

If you use magnification within the 3D Cursor target area, the system magnifies 
all images that contain the 3D Cursor target area simultaneously by the same 
amount. The target area is approximately centered in each magnified image. 
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About Position-linked Scrolling 
You can simultaneously view multiple adjacent series while synchronizing the 
views to the same patient position. Position-linked scrolling enables you to 
compare multiple exam series images simultaneously.  

Be aware of the following requirements and functions regarding position-linked 
scrolling: 

 Requirements. 

 How position-linked scrolling works. 

Requirements 
 Each series in the comparison must consist of DICOM images. 

 The Page Through Series tool must be active. 

 The comparison series must be adjacent to the primary series vertically 
or horizontally. They can be on different monitors, if they are in the same 
row. 

How position-linked scrolling works 
 Register the starting point. The starting point must be registered for 

each series. 

 Primary series. The primary series is the image you select and scroll 
through by:  
 Pressing the Ctrl key. 
 Clicking the left mouse button. 
 Moving the mouse. 

 Comparison series. You can compare up to four series and synchronize 
the images you are scrolling to the primary series image.  

 Scrolling in each series. Each series scrolls to the slice that is nearest the 
patient position of the primary series. 

Caution: Some images may be skipped in one or more series while scrolling. 
The thickness of the slices and the number of images in a series affect which 
images are displayed while scrolling. Position-linked scrolling displays the image 
closest to the primary image and may skip one or more images to accomplish 
that. 

Warning: Do not mark an exam read, if you exclusively used position-
linked scrolling to view the images. In most cases, you did not view all the 
images. 

 Compares position of image centers. Position-linked scrolling 
compares the positions of the image centers, not where you clicked the 
mouse. 

 Stops or loops back to original image. Scrolling stops or loops back to 
the original image when you page to the end of the primary series 
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regardless of the end of the comparison series. 
You can set the looping or stopping functions in one of the following 
dialog boxes: Reading Physician Preferences or Image Panel Properties. 

 Calculating slice thickness. If you release the Ctrl key while scrolling, 
scrolling continues but does not continue to calculate slice thicknesses 
with the comparison series. The image slices are no longer synchronized 
to the closest anatomical position of the primary series. 

 Accounting for reverse scrolling. The system accounts for cases where 
two series are assembled in reverse order. For example, one series 
progresses from anterior to posterior, while the other progresses from 
posterior to anterior. When you scroll one series forward the other scrolls 
backward. 

 Setting preference for position-linked scrolling. You can set a 
Reading Physician Preference to Use position-linked scrolling as a 
default. This option makes position-linked scrolling the default. Clearing 
this option makes position-linked scrolling available by pressing the Ctrl 
key while using the Page Through Series tool. For details on setting 
preferences, see "Reading Physician Preferences dialog box." 

Position-linked Scrolling for Comparison 
 Position-linked Scrolling for Comparison 

 Synchronizing scrolling in primary and comparison exams 

About position-linked scrolling for comparison 
You can synchronize adjacent slice views to the same patient position for 
comparison. 

Note: You must register the starting point for each series you are comparing. You 
are registering the image centers of the two series. After you register the starting 
point, position-linked synchronized scrolling is automatic for each series in the 
comparison.  

Synchronizing scrolling in primary and comparison exams 
To scroll through a series and synchronize with the same slice in the comparison 
series: 

1. View or read an exam. 

2. Arrange up to four series in adjacent image squares. 
 
Tip: Insert a scout on each image to simplify the process of aligning the 
series. 

3. Click the Page Through Series tool . 
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4. Scroll each series individually until the image with the slice you want to start 
with is displayed.  
 
Tip: Select the starting point in the scout. The slice line enables you to select 
parallel starting points. 
 

 
5. Move the cursor near the border of two adjacent series or to the intersection 

of up to four adjacent series that you want to compare. The primary image is 
the square containing the cursor. 
 
To compare series in adjacent monitors, move the cursor toward the edge of 
a comparison image window.  

 Horizontal and vertical position-linked scrolling 
 

 
 Horizontal position-linked scrolling across monitors 

 

 
 Position-linked scrolling of four squares 
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6. While the page tool is selected, press and hold the Ctrl key, click and hold 
the left mouse button, and move the mouse. 
 
This triggers the position-linked scrolling. Each comparison series scrolls to 
the same slice of the primary series. 
 

 
  

7. Scroll to the end of the primary series.  

 If looping is turned off, the scrolling stops.  

 If looping is turned on, the scrolling returns to the original position of the 
primary and comparison series. 

Flipping between Images for Comparison—Quick Flip 
 About flipping between images for comparison. 

 Flipping between images on the same monitor. 

 Flipping between images on different monitors. 

About flipping between images for comparison 
While you are comparing images, you can temporarily switch from the primary 
image to a comparison image, which allows you to keep both images in your 
immediate focus. The system switches the images in the current square. Quickly 
flipping between images in the same place is useful in detecting differences in 
size and location, for example when examining tumor growth. 

Using this Quick Flip tool, you can temporarily replace the primary image with 
the comparison image, and continue to switch quickly back and forth to 
determine differences between the two images: 

 Flipping between images on the same monitor. 

 Flipping between images on different monitors. 
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Flipping between images on the same monitor  
To flip between the primary image and a comparison image on the same monitor: 

1. View the exam in the Universal Manager. 

2. Select Series per Square Mode. If it is not the default set in the Reading 
Physician Preferences, do one of the following: 

 Press the Z key on the keyboard. 
 
OR 

 On the View menu, click Layout Images and select Series per Square 
Mode. 

3. Display the comparison image in the adjacent window. 

4. Click the Page Through Series button . 

5. Select the primary image by clicking in its square.  

6. Move the cursor toward an edge of a comparison image window that is 
shared with the primary exam window. Do not move the cursor beyond the 
primary image window. 
 

 
  

7. Press and hold the F key. 
The comparison image overlays the primary image and remains displayed in 
the adjacent comparison window. 
 

 
  

8. Release the F key. The system removes the comparison image from the 
primary image window. 
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9. Continue pressing and releasing the F key to quickly flip between the two 
images. 

10. You can move the cursor toward another edge of a different comparison 
image window.  

 Press the F key. That comparison image overlays the primary image.  

 Release the F key to display the primary image.  

 Repeat to flip between the two images. 

Flipping between images on different monitors 
To flip between a comparison image in an adjacent monitor and the primary 
image: 

1. Access the primary and comparison image as described in Flipping between 
images on the same monitor. 

2. Move the cursor toward the edge of a comparison image window in an 
adjacent monitor.  
 

 
  

3. Press the F key. The comparison image from the adjacent monitor overlays 
the primary image.  

4. Release the F key to display the primary image.  

5. Repeat to flip between the two images. 

Shuffling Images for Comparison 
 About shuffling images 

 Tracking primary and comparison images while shuffling 

 Shuffling a primary exam and a comparison exam by series name 

 Shuffling a primary exam and a comparison exam by series name 1:1 

 Shuffling primary exam images and adjacent comparison exam images 

 Shuffling a primary exam and a comparison exam by series name 1:1 
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About shuffling images 

Description of shuffling 

Shuffling momentarily stacks in a single window the first primary exam image 
followed by the first image in each successive comparison exam. This repeats for 
the second image in the primary and comparison exams, followed by the third 
image in each series, until the system displays all the images in the primary exam 
and the successive comparison exams. This allows you to view a series of 
interlaced primary exam series images and up-to-four comparison exam series 
images. 

 
Shuffling order 

The order the images are displayed as you page through the sets of images is: 

1. Primary Exam Series, image 1. 

2. Comparison Exam 1 series, image 1. 

3. Comparison Exam 2 series, image 1. 

4. Comparison Exam 3 series, image 1. 

5. Primary Exam series, image 2. 

6. Comparison Exam 1 series, image 2. 

7. Comparison Exam 2 series, image 2. 

8. Comparison Exam 3 series, image 2. 

9. Primary Exam series, image N. 

10. Comparison Exam 1 series, image N. 

11. Comparison Exam 2 series, image N. 

12. Comparison Exam 3 series, image N. 
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Caution: Labels on the exam images provide information for you to track the 
exam you are viewing. Verify that system annotations are displayed before 
shuffling. For details see, "Tracking primary and comparison images while 
shuffling." 

Shuffling principles 

Be aware of the following when using shuffling: 

 Primary and comparison series must be graphically similar to effectively 
use shuffling. 

 Primary and comparison series must have the same name to use the 
Shuffle by Series Name option. 

 Shuffling is most helpful when the primary and comparison exam series 
have the same: 
 Anatomical area 
 Image size 
 Order or images 

 The exams to be shuffled must be open. 

Shuffling options 

You can choose to shuffle by: 

 Shuffle by series name. Shuffle the primary and comparison exam 
series of the same name. 

 Shuffle by series name 1:1. Same as Shuffle by series name, except the 
display uses the full panel. 

 Shuffle adjacent. Select the comparison series to shuffle with the 
primary exam series by moving the mouse near an edge between the 
series. 

 Shuffle adjacent 1:1. Same as Shuffle adjacent, except the display uses 
the full panel. 

Tracking primary and comparison images while shuffling 
To know which image you are viewing while shuffling primary and comparison 
exam images, watch the following labels: 

Tip: Press A to toggle image labels on if they aren't showing. 

 Shuffled tag . If the system shows the shuffle tag at the top of the 
image, you are viewing a series of shuffled images. 

 Other tag: The Other tag at the bottom right shows the comparison 
exam and date. 
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 Exam date and time. Each image shows the exam date and time.  

 Exam image number and series name. Shows the series name and the 
position of the image within the series. 
 

 

Shuffling a primary exam and a comparison exam by series name 
To shuffle primary exam and comparison exam series of the same name: 

1. Open the primary exam and the comparison exam, for example: 

 A primary left and right breast exam, Mammo LT Series and Mammo 
RT Series. 

 A comparison left and right breast exam, Mammo LT Series and 
Mammo RT Series. 
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 Caution: If you do not see the image name and date and time stamp 
annotations in the corners, click A. For details on the page annotations, 
see "Tracking primary and comparison images while shuffling." The 
annotations give you information you need to ensure you know which 
image you are viewing.  

2. Select the Page Through Series tool. 

3. Determine which series you want to shuffle. Use the Page Through Series 
tool to position each of the series to the desired starting image. 

4. Right-click an image.  
The shortcut menu opens.  

5. Select one of the following commands: 

 Shuffle by Series Name. 

 Shuffle by Series Name 1:1. 
 
The cursor changes to a series of a black pages interlaced with white 
pages. 
 

 
6. Click and hold the mouse on a series that you want to shuffle. 

 
A Shuffle tag appears at the top of the image to show that you are in shuffle 
mode . This tag appears on each image while you are in shuffle mode. 

7. Drag the mouse to view the first comparison image. 
 
As you continue to move the mouse, the image you are viewing quickly 
pages through the interlaced primary and comparison images in each series in 
the following pattern: 

 First primary image. 
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 First comparison image. 

 
  

 Second primary image. 

 
  

 Second comparison image. 

 
 
This pattern repeats for each series of the same name. 



Web Ambassador Guide - Release 7 

Using Viewing Tools Comparing exams  •  3-27 

8. Pause shuffling by releasing the mouse button. 

9. Exit shuffling by selecting one of the following: 

 Page through series tool from the shortcut menu. 

 Another tool from the toolbar or the menus. 

Tip: After using other tools, you can press Q to resume using the Page Through 
Series tool in shuffling mode. 

Shuffling a primary exam and a comparison exam by series name 
1:1 
The differences between Shuffle by Series Name and Shuffling by Series 
Name 1:1 are: 

 Shuffle by Series Name 
 Performs the shuffle operation in the same window where you click 

the tool. 
 Restores the previous layout when you release the mouse button. 

 Shuffle by Series Name 1:1  
 Displays the shuffled images in one panel that fills the entire display. 
 Displays a Clear Shuffle  button at the top of the 

panel after you release the mouse button to let you exit shuffle mode 
and return to the original layout of images. 

 Allows you to perform multiple shuffle operations simultaneously.  

Shuffling Adjacent Series 
To shuffle the images of up to four adjacent exam series: 

1. Select the Page Through Series tool. 

2. Determine which series you want to shuffle. Use the Page Through Series 
tool to position each of the series to the desired starting image. 

3. Right-click an image and select one of the following commands from the 
shortcut menu: 

 Shuffle Adjacent 

 Shuffle Adjacent 1:1  
 
The cursor changes to a series of black pages interlaced with white 
pages. 
 

 
4. Move the mouse near the image you want to compare.  

As you approach the edge, the cursor changes to show which adjacent series 
will be shuffled with the primary series. 
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 The following cursors shuffle images in two adjacent series: 
 

               

 The following cursors shuffle images in up to four adjacent series: 
 

               
  

5. Click-left and hold the mouse button. 
 
A Shuffle tag appears at the top of the image to show that you are in shuffle 
mode . This tag appears on each image while you are in shuffle mode. 

6. Drag the mouse to view the first image from an adjacent series. 
 
As you continue to move the mouse, the image your are viewing quickly 
pages through the images of each series. 
 
You remain in shuffle mode while the shuffling cursor is active. 

7. Release the mouse button. 
 
The shuffling stops and the series involved in the shuffle are updated to 
display the last image viewed.  

Shuffling Adjacent Series 1:1 
The differences between Shuffling Adjacent and Shuffle Adjacent 1:1 are:  

 Shuffle Adjacent 
 Performs the shuffle operation in the same window where you click 

the tool. 
 Restores the previous layout when you release the mouse button. 

 Shuffle Adjacent 1:1  
 Displays the shuffled images in one panel that fills the entire display. 

 Displays a Clear Shuffle button at the top of 
the panel to let you exit shuffle mode and return to the original 
layout of images. 

 Allows you to perform multiple shuffle operations simultaneously.  
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Adding text, arrow, and measurement annotations  to primary exam 
images while shuffling 
To add annotations to the primary exam images while shuffling: 

1. Page through the images in the shuffling mode Shuffle by Series Name 1:1 
or Shuffle Adjacent 1:1. 

2. Release the mouse at the image you want to annotate.  

3. Insert annotations as needed.  
 
The annotations are saved with the image.  

Cropping 

Cropping Images 
 About cropping 

 Cropping an image 

 Cropping multiple images in series 

 Using keyboard shortcuts 

About Cropping 

 Warning:   If you crop an image and save it when you close the exam, 
you cannot restore the original image. 

Cropping an image 
To crop an image: 

1. Click the Crop button . 

2. Click and drag to select the portion of the image you want to keep. The 
portion of the image outside the box will be deleted.  

3. To adjust the size or position of the box, click on the box outline.  

 Use the squares on the outline to adjust the size.  

 Click the shaded outline and drag to move the box.  

4. Right-click the image.  From the shortcut menu, select Preview cropping for 
this image. 
 
The system displays a preview of the cropped image. 

5. You can cancel the preview, delete the crop box, or save the previewed 
image. 

 To delete the crop box, right-click and select Delete crop box for this 
image. 
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 To cancel the preview but keep the crop box, right-click Cancel preview 
for this image. 

 To save the cropped image, exit the exam. 
The system prompts you to decide if you want to save the cropped image 
when you exit the exam. 
 
Warning:   If you crop an image and save it when you close the exam, 
you cannot restore the original image. 

Cropping multiple images in series 
To crop multiple images: 

1. Click the Crop button . 

2. Click and drag to select the portion of the image you want to keep. The 
portion of the image outside the box will be deleted.  

3. To adjust the size or position of the box, click on the box outline.  

 Use the squares on the outline to adjust the size.  

 Click the shaded outline and drag to move the box.  

4. Right-click the image.  From the shortcut menu, select one of the following 
options: 

 Copy this crop box to all series images. 

 Copy this crop box to following series images. 

5. From the shortcut menu, select Preview cropping all series images. 
 
The system displays a preview of the cropped image. 

6. You can cancel the preview, delete the crop box, or save the previewed 
image. 

 To delete the crop box, right-click and select Delete crop box for all 
series images. 

 To cancel the preview but keep the crop box, right-click Cancel preview 
for all series images. 

 To save the cropped images, exit the exam. 
The system prompts you to decide if you want to save the cropped 
images when you exit the exam. 
 
Warning:   If you crop an image and save it when you close the exam, 
you cannot restore the original image. 
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Using keyboard shortcuts 
You can use the following keyboard shortcuts for the Crop tool: 
 

Shortcut Tool  Action 

> or . 

 

Crop Mode to apply action to all images in the series.  After you 
apply the shortcut, the cursor displays an "A" (for All). 

Shift 
 

Crop Immediately shows a preview of the cropped image. 

Caution when using the > key, Apply to Whole Series 

When using the > shortcut or the View menu option Apply to Whole Series to 
apply the imaging tool to all images in the series, you may affect images that are 
not currently visible on the display. 

Image Subtraction Masks 

About Applying Image Subtraction Masks 

Image subtraction masks 
The system provides image subtraction masks between two frames of a 
multiframe image if the DICOM header or the Image Processing tool enables 
subtraction. By using subtraction, you can, for example, focus on the movement 
of the contrast agent in an image. When viewing a subtracted-image series by 
using the cine tool or by paging through the series, all frames are subtracted.  

The following is an example subtracted image that shows the contrast agent 
beginning to flow through a vessel: 
 

 

About the mask 

A mask is an image used to subtract from each of the images in a set of one or 
more images. Typically a mask image is an image that is captured before a 
change is introduced into the set of images to be subtracted, for example, before 
introducing a contrast agent. 
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About subtraction 

Subtraction is an image processing operation that is performed between a mask 
and a reference image. The system displays the subtracted result, which provides 
the ability to focus on the differences between the mask and the subsequent 
images. 

Displaying and removing subtraction 
You have the option to: 

 Apply the mask subtraction to each frame of a multiframe sequence. 
 Disable mask subtraction to view the images without mask subtraction. 
 Opacify the subtracted image, which accumulates a series of subtractions 

to emphasize particular detail. 

Specifications of mask subtraction 
 When your run the cine tool on a subtracted image, all images in the cine 

sequence are subtracted. 

 The DICOM header controls whether the system displays the first image 
in the series in subtracted format or normal format. 

 The first image, which is subtracted from itself, results in a "zero" image 
that appears as a flat, gray field. 

 The system applies the current Window-Level, Rotation, and Image 
Processing settings to all images in the sequence. 

Availability of viewing mask subtracted images 
Mask subtraction is available on the following DR Systems products: 

 Dominator 

 Web Dominator 

 Ambassador 

 Web Ambassador 

 Catapult 

For details on using image subtraction, see 
 Accessing Exams to View Subtracted Images 

 Determining if Images Have a Subtraction Mask Defined 

 Viewing Subtracted Images 

 Disabling Subtraction Masks 

 Activating Image Subtraction 

 Opacifying Subtracted Images 
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Accessing Exams to View Subtracted Images 
To access an exam to view the subtracted images: 

1. Select the exam. For details on selecting exams, see "Selecting Exams in a 
List." 

2. Click the View button . 
 
Tip: You can also double-click the exam, or right-click and select View from 
the shortcut menu. 
 
The exam and the Electronic Requisition open. 
 

 
  

3. Close the Electronic Requisition.  
 
Tip: Press the spacebar. 
 

Determining if Images Have a Subtraction Mask Defined 
To determine if the image you are viewing has a defined subtraction mask: 

1. Access the exam. For details on accessing the exam, see "Accessing an exam 
to view subtracted images." 

2. Select the Apply Image Processing tool . 

3. Right-click the exam image. 
The Apply Image Processing menu opens. 

4. View the available options in the menu. 

 If the Subtraction menu items are listed, you can apply a subtraction 
mask to the images in the exam.  

 If the image does not have a subtraction mask defined, the system does 
not list Subtraction menu options. 
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Viewing Subtracted Images 

About viewing subtracted images 
The DICOM header specifies the default. If image subtraction is the default, the 
image opens displaying the image subtracted. If the default does not display 
image subtraction, you can activate it. For details on activating image 
subtraction, see "Activating Image Subtraction." 

View subtracted images 
To view subtracted images: 

1. Access the exam. For details on accessing the exam, see "Accessing an exam 
to view subtracted images." 

2. Click the Cine tool  and click the image. 
 
The system subtracts the mask from all the images as they are displayed. The 
mask image is displayed as black. For details on using the cine tool, see 
"Using Cine for Continuous Viewing of a Series." 
 
The following figure is the third image of a cine sequence that shows the 
contrast agent continuing to flow through a vessel: 
 

 
 
The following figure is the fourth image of a cine sequence that shows the 
contrast agent continuing to flow through a vessel: 
 

 
  

3. To view each image in detail, stop the cine sequence by clicking on the exam 

image and selecting the Page-Through-Series tool . 
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Disabling Subtraction Masks  
To remove the subtraction mask from images while you are viewing the exam: 

1. Access the exam. For details on accessing the exam, see "Accessing an exam 
to view subtracted images." 

2. Select the Apply Image Processing tool . 

3. Right-click the exam image that includes image subtraction.  
The Apply Image Processing menu opens. 

4. Click Cancel Image Processing. 
 
The system removes the image subtraction. 
 
The following figures show the same image with subtraction canceled and 
with subtraction active: 

 Image with subtraction cancelled: 
 

 
  

 Image with subtraction activated: 
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Activating Image Subtraction 
To activate image subtraction: 

1. Access the exam. For details, see "Accessing exams to view subtracted 
images." 

2. Select the Apply Image Processing tool . 

3. Right-click the image that has mask subtraction off. 
The Apply Image Processing menu opens.  

4. Select Apply Subtraction. 
 
The system displays the subtracted images. 

Opacifying Subtracted Images 

About opacifying subtracted images 
Opacification accumulates a series of subtracted images to emphasize a particular 
detail. Each image builds on the previous image. Subtracted images displayed 
without opacify show each image as the contrast agent flows through the vessel 
and the previous image has no effect on the current image. 

Opacifying a subtracted image 
To opacify the subtracted image: 

1. Access the exam. For details on accessing the exam, see "Accessing an exam 
to view subtracted images." 

2. Select the Apply Image Processing tool . 

3. Right-click the image with mask subtraction. 
 
If you are not on the first image, scroll to the first image in the series. 
 
The Apply Image Processing menu opens. 

4. Select Apply Subtraction Opacify. 
 
The following is an example of a series of subtracted images with 
opacification turned on. The figure shows the contrast building from the first 
subtracted image to the last.  
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Images with opacification 

   

Images without opacification 

   

 

Interpolation 

Controlling Image Interpolation for Display  
Images can be resized to be larger than originally acquired. If very small images 
are enlarged or magnified many times, they can appear blocky or pixellated 
depending on what algorithm is used to increase the size of the image. 

DR Systems supports Pixel Replication and Bilinear Interpolation when 
enlarging images for display. 

Controlling Image Interpolation for Printing  
Images can be resized to be larger than the original acquisition size. If very small 
images are enlarged or magnified many times, they can appear blocky or 
pixelated depending on what algorithm is used to increase the size of the image. 

When enlarging items for display, DR Systems supports the following resizing 
methods: 

 Pixel replication 

 Bicubic interpolation 

 Bilinear interpolation 

The resizing method is controlled when you select the printing options for the 
print job. Bilinear interpolation or Bicubic interpolation should be used for 
optimal image quality, especially with smaller images (256 x 256 or less).  
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Using Bilinear Interpolation and Pixel Replication  
When small images are magnified they can appear blocky or “pixilated.” Bilinear 
Interpolation smoothes the block appearance of the image for better viewing. 
Bilinear Interpolation should be used for optimal image quality, especially with 
smaller images (256x256 or less). The Bilinear Interpolation feature is on as 
default. If deselected, the image will be resized by the Pixel Replication method.  

To turn off bilinear interpolation, and turn on pixel replication:  

1. Click the View menu.  

2. Select Bilinear Interpolation.  

Inverting, Rotating, and Flipping 

Inverting an Image  
 About Inverting 

 Inverting one image 

 Inverting all images in a series 

 Using keyboard shortcuts 

About Inverting 
Use the Invert function to show the negative of the image. 

Inverting one image 
To invert an image:  

1. Click the Invert button . 

2. Click the image to view the negative. 

Inverting all images in a series 
To invert all images in a series:  

1. Click the Invert button . 

2. Right-click the image with the Invert tool. 

3. Select Apply invert to all series images. 
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Using keyboard shortcuts 
You can use the following keyboard shortcuts for the Invert tool: 
 

Shortcut Tool  Action 

> or . 

 

Invert Mode to apply action to all images in the series. 
 After you apply the shortcut, the cursor displays an 
"A" (for All). 

Caution when using the > key, Apply to Whole Series 

When using the > shortcut or the View menu option Apply to Whole Series to 
apply the imaging tool to all images in the series, you may affect images that are 
not currently visible on the display. 

Rotating and Flipping an Image 
 About rotating and flipping images 

 Flipping the image from left to right 

 Flipping the image from top to bottom 

 Rotating the image 

 Using keyboard shortcuts 

About rotating and flipping images 
You can flip the image or rotate it in 90-degree increments. 

Flipping the image from left to right 
To flip the image left to right: 

1. Click the Rotate button . 

2. Right-click the image. 

3. From the shortcut menu, select Mirror Right/Left. 

Flipping the image from top to bottom 
To flip the image top to bottom: 

1. Click the Rotate button . 

2. Right-click the image. 

3. From the shortcut menu, select Flip Top/Bottom. 
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Rotating the image 
To rotate the image: 

1. Click the Rotate button . 

2. Right-click the image. 

3. From the shortcut menu, select one of the following options: 

 Rotate Right 90 

 Rotate Left 90 

 Rotate 180 

4. Click the image. 
 
Note: The shortcut menu has options for applying operations to other images 
in the series. You can right-click the image and select an option to apply the 
rotate/flip to all the series images or the following series images.  

Using keyboard shortcuts 
You can use the following keyboard shortcuts for the Rotate tool: 
 

Shortcut Tool  Action 

> or . 

 

Mirror left-right 

 

 

Flip top-bottom 

 

 

Rotate 180 degrees 

 

 

Rotate left 90 degrees 

 

 

Rotate right 90 degrees 

Mode to apply action to all images in the 
series.  After you apply the shortcut, the 
cursor displays an "A" (for All). 

Caution when using the > key, Apply to Whole Series 

When using the > shortcut or the View menu option Apply to Whole Series to 
apply the imaging tool to all images in the series, you may affect images that are 
not currently visible on the display. 
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Flipping between Images for Comparison—Quick Flip 
 About flipping between images for comparison. 

 Flipping between images on the same monitor. 

 Flipping between images on different monitors. 

About flipping between images for comparison 
While you are comparing images, you can temporarily switch from the primary 
image to a comparison image, which allows you to keep both images in your 
immediate focus. The system switches the images in the current square. Quickly 
flipping between images in the same place is useful in detecting differences in 
size and location, for example when examining tumor growth. 

Using this Quick Flip tool, you can temporarily replace the primary image with 
the comparison image, and continue to switch quickly back and forth to 
determine differences between the two images: 

 Flipping between images on the same monitor. 

 Flipping between images on different monitors. 

Flipping between images on the same monitor  
To flip between the primary image and a comparison image on the same monitor: 

1. View the exam in the Universal Manager. 

2. Select Series per Square Mode. Radiologist PreferencesIf it is not the 
default set in the Reading Physician Preferences, do one of the following: 

 Press the Z key on the keyboard. 
OR 

 On the View menu, click Layout Images and select Series per Square 
Mode. 

3. Display the comparison image in the adjacent window. 

4. Click the Page Through Series button . 

5. Select the primary image by clicking in its square.  

6. Move the cursor toward an edge of a comparison image window that is 
shared with the primary exam window. Do not move the cursor beyond the 
primary image window. 
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7. Press and hold the F key. 
The comparison image overlays the primary image and remains displayed in 
the adjacent comparison window. 
 

 
  

8. Release the F key. The system removes the comparison image from the 
primary image window. 

9. Continue pressing and releasing the F key to quickly flip between the two 
images. 

10. You can move the cursor toward another edge of a different comparison 
image window.  

 Press the F key. That comparison image overlays the primary image.  

 Release the F key to display the primary image.  

 Repeat to flip between the two images. 

Flipping between images on different monitors 
To flip between a comparison image in an adjacent monitor and the primary 
image: 

1. Access the primary and comparison image as described in Flipping between 
images on the same monitor. 

2. Move the cursor toward the edge of a comparison image window in an 
adjacent monitor.  
 

 
  

3. Press the F key. The comparison image from the adjacent monitor overlays 
the primary image.  

4. Release the F key to display the primary image.  

5. Repeat to flip between the two images. 
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Magnifying and Roaming 

Magnifying Images 
 About Magnifying Images 

 Magnifying an image. 

 Using keyboard shortcuts. 

About Magnifying Images 
This function magnifies the entire image.  You can also magnify a portion of the 
image. 

Magnifying an Image 
To magnify an image:  

1. From the Tools menu, select Magnify. 
OR 

On the toolbar, click the Magnify button . 

2. Press and hold the left mouse button as you move the magnifying glass over 
the image. 

 Moving the mouse forward increases the magnification. 

 Moving the mouse back decreases the magnification.  

3. When you reach the desired magnification, release the mouse button.  

4. To select a magnification option, right-click the image and select one of the 
following: 

 Apply last magnification to this image.  

 Reset to the original magnification.  

 Apply magnification to all series images.  

 Apply magnification to following series images. 

Using keyboard shortcuts 
You can use the following keyboard shortcuts for the Magnify tool: 
 

Shortcut Tool  Action 

> or . 

 

Magnify Mode to apply action to all images in 
the series.  After you apply the 
shortcut, the cursor displays an "A" (for 
All). 
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Caution when using the > key, Apply to Whole Series 

When using the > shortcut or the View menu option Apply to Whole Series to 
apply the imaging tool to all images in the series, you may affect images that are 
not currently visible on the display. 

Magnifying a Portion of the Image  

About magnifying a portion of the image 
The Mag Box magnifies a small area of the image. The magnification default is 
Full Resolution. The Mag Box is the default tool when viewing an image.  

Using the Mag Box 
To use the Mag Box: 

1. Place the Mag Box over the image.  

2. Press and hold the left mouse button as you move the Mag Box over the 
image.  

3. Right-click and select a Mag Box option:  

 Change the magnification to 2X or 4X. 

 Change the size of the Mag Box. 

Magnifying Portions of Adjacent Images Simultaneously 
 About magnifying portions of primary and comparison images 

simultaneously 

 Magnifying portions of primary and comparison images simultaneously 

About magnifying portions of primary and comparison images 
simultaneously 

Caution: The position of the linked and mirrored magnification boxes are not 
patient relative. 

Linked and mirrored magnification boxes 

Linked and mirrored magnification boxes allow you to simultaneously: 

 Magnify the same general area of two images.  

 Move the magnification boxes in the same or opposite directions. 
 Linked magnification. Moves both magnification boxes in the same 

direction. 
 Mirrored magnification. Moves the boxes according to their 

relative positioning. If positioned side-by-side, the boxes move in 
opposite horizontal directions. If positioned one above the other, the 
boxes move in opposite vertical directions. 
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Requirements for using linked and mirrored magnification boxes 

Be aware of the following when using linked and mirrored magnification boxes: 

 Adjacent images. The images must share a window edge. They must be 
adjacent horizontally or vertically. 

 Linked graphically. The system links the magnification boxes 
graphically, not anatomically. Use magnification when comparing exams 
that are similar, for example: 
 The exams are of the same area but taken at different times 
 The exams are for left-and-right comparisons. 

 Left-click for linked magnification boxes. The system links the box 
movements as you drag the mouse horizontally and vertically. The 
magnification boxes move in parallel. 

 Right-click for mirrored magnification boxes. The system mirrors the 
box movements as you drag the mouse horizontally and vertically. The 
magnification boxes move in opposite directions on one axis and the 
same direction on the other axis. 
 Horizontal mirrored movement. If you position the adjacent 

images horizontally and drag the mouse horizontally, the system 
mirrors the magnification box movements. The system links the 
magnification box movements when you drag the mouse vertically. 

 Vertical mirrored movement.  If you position the adjacent images 
vertically and drag the mouse vertically, the system mirrors the 
magnification box movements. The system links the magnification 
box movements when you drag the mouse horizontally. 

 Movement in different sized images. If the adjacent images are 
different sizes, the magnification boxes move an equivalent percentage 
of the images size. For example, if the image in the adjacent window is 
twice the size of the primary image, each movement in the primary 
image moves twice as many pixels in the adjacent image. 

Magnifying portions of two images simultaneously 
To magnify a portion of a two images simultaneously: 

1. Display two images. 

2. Click the Mag Box button . 
 

The cursor changes to a boxed magnifying glass . 

3. Drag the cursor to the edge adjacent to the an image. 
 
The cursor changes to one of the following depending on the edge of the 
image where you place the cursor: 
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4. Do one of the following: 

 Linked magnification boxes. Click-left and hold the mouse button for 
linked magnification boxes. 

 Mirrored magnification boxes. Click-right and hold the mouse button 
for mirrored magnification boxes. 

5. While holding the left or right mouse button, drag the cursor over the exam.  
 
A magnifying box in both images enlarges the same geographic areas of the 
two images. The magnifying boxes move simultaneously horizontally and 
vertically as you move the mouse. 
 

 

Roaming  

About Roaming 
Roaming moves the image within a cell if the image is magnified so it is larger 
than the cell.  

Using the Roam tool 
To roam: 

1. Click the Roam button . 

2. Place the icon on the image you want to roam.  

3. Move the icon to view the image.  

Roaming Adjacent Images Simultaneously 

About roaming adjacent images simultaneously 
You can use the roaming tool to simultaneously move two adjacent images. 
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Linked and mirrored roaming 

Linked and mirrored roaming allows you to simultaneously: 

 Roam to the same general area of two adjacent exams.  

 Move two images in the same or opposite directions. 
 Linked roaming. Moves the two images in the same direction. 
 Mirrored roaming. Moves the two images in opposite directions. 

Linked and mirrored roaming principles 

Be aware of the following when using linked and mirrored roaming: 

 Images are larger than the display area. To use the Roaming tool, the 
images must be larger than the display area allocated for them. 

 Adjacent images. The images must be adjacent horizontally or 
vertically. They must share a window edge.  

 Linked graphically. The system links the roaming graphically, not 
anatomically. Use roaming when comparing exams that are similar, for 
example: 
 The exams are of the same area but taken at different times. 
 The exams are for left-and-right comparisons. 
 The exam images are magnified similarly and your view of the 

images is similar. 

 Left-click for linked roaming. The system links image movements as 
you drag the mouse horizontally and vertically. The images move in 
parallel. 

 Right-click for mirrored roaming. The system mirrors the image 
movements as you drag the mouse horizontally and vertically. Images 
move in opposite directions on one axis and the same direction on the 
other axis. 
 Horizontal mirrored movement. If the images are side-by-side and 

you drag the mouse horizontally, the system mirrors the image 
movements. The system links the image movement when you drag 
the mouse vertically. 

 Vertical mirrored movement. If the images are one-above-the-
other and you drag the mouse vertically, the system mirrors the 
image movements. The system links the image movement when you 
drag the mouse horizontally. 

 Movement in different sized images. If the adjacent images are 
different sizes, the images move an equivalent percentage of the images 
size. For example, if the image in the adjacent window is twice the size 
of the primary image, each movement in the primary image moves twice 
as many pixels in the adjacent image. 
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Roaming two images simultaneously 
To roam two images simultaneously: 

1. Open two or more images. 
 

 

2. Click the Roam button . 
 

The cursor changes to a hand for grabbing the image and moving it . 

3. Drag the mouse to the window edge of the adjacent image. 
 
The cursor changes to one of the following depending on the edge of the 
image where you place the cursor: 
 

               

4. Click and drag the mouse to roam images in both exams simultaneously. 
 

 

Pixel Tracking 

About pixel tracking 
Use pixel tracking to identify how much of the image you have viewed. 

When to use pixel tracking 

This tool is useful when: 

 You are viewing an image that is larger than the display area of your 
monitor. 

 You want to be sure that you have viewed the entire image. 
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Tools that enable pixel tracking 

You can use pixel tracking with the following tools: 

 MagBox tool  

 Roam tool  

Using pixel tracking with the MagBox tool 
1. Be sure that shrink mode is on. 

If shrink mode is not turned on, press the S key to turn it on. 
Tip:  The character 'S' displays at the right of the status bar at the bottom of 
the window. 
 

 

2. Click the MagBox tool . 

3. Use the MagBox tool to view some areas of the image. 
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4. Press and hold the Insert key. 
 

 
 The viewed area is displayed in the original color. 

 The unviewed area is displayed in reversed color. 

5. Release the Insert key to return to normal view. 

6. Continue using the MagBox until you have viewed all the areas of interest.  
 
Note:  When you finish viewing the exam, the system clears the pixel 
tracking. 

Using pixel tracking with the roaming tool 
1. Be sure that shrink mode is off. 

If shrink mode is turned on, press the s key to turn it off. 
Tip:  The character 'S' does not display at the right of the status bar at the 
bottom of the window. 
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2. Click the Roam tool . 

3. Use the Roam tool to pan through some areas. 

4. Press and hold the Insert key. 
 

 
  

 The viewed area is displayed in the original color. 

 The unviewed area is displayed in reversed color. 

 The current viewing area is marked by a box. 

5. Move the viewing box to another area. 

 
  

6. Release the Insert key to return to normal view. 
The view area is moved to the designated area. 

7. Continue using the Roam tool until you have viewed all the areas of interest. 
 
Note:  When you finish viewing the exam, the system clears the pixel 
tracking. 
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Scout Insets 

Creating a Scout Inset for Specific Images in a Series  
For some series it may be useful to plot only half of the series images, or to have 
two scout insets with a portion of the series plotted on each.  

To create a scout inset for specific images:  

1. Plot the entire series.  

2. Click the Cross-ref scout button . 

3. With the Cross-ref scout tool, right-click an image in the series.  

4. Choose Select slices. A dialog box appears showing the scout inset with the 
slices plotted.  

5. Click Select Slices. The slice lines become shorter.  

6. Click on the image and drag to create a box around the slice lines that should 
have the scout inset.  

7. Click OK.  

Note: To have portions of the series plotted on two scout insets, create the two 
scout insets and then separately specify which images are to be plotted to which 
scout inset.  

Selecting a Scout Inset to Display  
Although more than one scout can be put as an inset on a series, only one scout 
inset can be displayed at a time.  

To switch between insets:  

1. Click the Cross-ref scout button . 

2. Right-click a series image.  

3. Select Next scout or Previous scout from the shortcut menu. 

Moving and Resizing Scout Insets  
Scout insets can be moved to any place within the image and resized to any 
desired size.  

To move or resize the scout inset:  

1. Click the Cross-ref scout button . 

2. Click on the scout inset. Resize handles will appear on the inset.  

 To move the inset, click inside the inset and drag it to the desired 
location. 

 To resize the inset, click on a resize handle and drag to the desired size.  
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Removing a Scout Inset from a Series  
To remove a scout inset:  

1. Click the Cross-ref scout button . 

2. Right-click the image.  

3. Select Unplot series from the shortcut menu. 

Viewing Scout Insets at Full Resolution  
To view a scout inset at full resolution:  

1. Click the Cross-ref scout button . 

2. Double-click on the scout inset. The inset appears in a dialog box.  

3. Resize the dialog box to enlarge or shrink the scout inset.  

4. When finished, click OK.  

Scrolling 

Scrolling Images  
When viewing exams in Image per Square display mode, the scroll function will 
move through the panels.  

Note: This mode of viewing is the same as the All Series Monitor mode on the 
DOS Dominator.  

To use Scroll:  

1. Click the Scroll button. 

2. Click an image to move it to the start of the first panel. 

Series 

Applying Roaming to all Images in Series 

About applying Roaming to all Images in Series 
You can simultaneously roam all the images in a series by using the Roam tool. 
By using the Roam tool with the Apply to Whole Series option activated, you 
can grab-and-roam all the images in the series. 

Caution: Using roaming can move important parts of exams that have not yet 
been displayed out of the viewing range. 
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Realigning all images in a series 
To apply roaming to all images in a series: 

1. Open a series in any display mode. 
 

 

2. Click the Roam button .  

3. Press the greater-than key > to activate Apply to Whole Series. 
 
Tip: You can also select Apply to Whole Series from the View menu. 
 

The cursor changes to the Roam Series icon . 

4. Click and hold. Drag the mouse on one image to move all the images in the 
series. 
 

 

Replacing the Viewed Series 
You can replace the series you are viewing with another series while you are in 
Series-per-Square mode. 

To replace a series you are viewing with another series:  

1. View an exam. 

2. Select Series per Square Mode. 
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If it is not the default set in the Reading Physician Preferences, do one of the 
following: 

 Select the Z key on the keyboard, 
 
OR 

 On the View menu, click Layout Images and select Series-per-Square 
Mode. 

3. Select the square with the series in it that you want replaced. 

4. Move the pointer to the lower left corner of the image. 
 

 
 
The Select Series button appears. 

5. Click the Select Series button. 
The Select-a-series-from-the-list dialog box opens. 
 

 
 
The system lists series from the primary exam as well as any series from the 
comparison exam, if they are loaded. 
 
Note: To close the dialog box without selecting a series, press the Esc key or 
the X close button in the window corner. 

6. Select the series name that you want to replace the current series, and press 
Return or double-click the series name. The dialog box closes.  
 
The system displays the series you selected in the square. 
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Selecting a Series to Display  
You can choose a series to display rather than paging through the entire exam.  

To select a series:  

1. When viewing an exam, click the Select Series button  
OR from the Tools menu, click Set Series. 
 
The Select Series dialog box opens. 
 

 
  

2. Do one of the following: 
 If you are viewing images in the Image-per-Square Display Mode: 

Double-click the desired series. The first image in the selected series 
displays. 
 
OR  

 If you are viewing images in the Series-per-Square Display Mode: 
Double-click the series to display. The mouse pointer changes to the 
series icon. 
 
Move the icon to a cell and click the left mouse button. The selected 
series displays in the selected cell.  

Specifying an Image in a Series to View 
To specify a specific image in a series to display: 

1. Open a series. 

2. Click the Page Through Series button . 

3. Move the mouse to place the Page-Through-Series cursor  over the 
series you want to view. 
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4. Right-click. 
 
The shortcut menu opens. 
 

 
  

5. Select Go to Image from the shortcut menu. 
 
The Display series image dialog box opens. 
 

 
 
The default Image number is the number of the currently displayed image. 

6. Type the image number of the image you want to view. 

7. Click OK. 
 
The system displays the image. 

Simultaneously Paging through Series Across Monitors 

About paging through series across monitors 
While viewing or reading exams that have multiple series displayed on multiple 
monitors, you can page all series simultaneously.  

For example, you open a primary exam and a comparison exam on four monitors: 

 Each of the two center monitors display a series from the primary exam. 

 The far left monitor displays a series from the comparison exam. 

 The far right monitor displays a series from the comparison exam. 

You can page through a series on one of the monitors and simultaneously page 
through the series on all the other monitors. 
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Paging through multiple series across monitors 
To simultaneously page through series of exam images all other monitors: 

1. Display multiple series in multiple monitors. 

2. Select the Page-Through-Series tool by doing one of the following: 

 Click the Page Through Series button . 

 Right-click on an image and select Page Through Series in the shortcut 
menu. 

3. Press and hold the Shift key while dragging the mouse. 
 
All the series page through their images simultaneously. 

Viewing a Series  
When viewing exams in Series per Square display mode, you can view the 
images in a series with the Page function.  

To page through a series:  

1. Click the Page button . 

2. Click and drag over the series to view.  

Note: If two exams are displayed, press Shift to page through both exams at the 
same time.  

Tips: If you need to select a different tool than the Page Through Series tool, 
press Q for the Quick Select Paging tool to return you to your previously used 
Page Through Series tool in shuffling mode. 

Window/Level and Image Processing 

Adjusting the Window/Level of an Image  
 About Window/Level 

 Window/Level for a single image 

 Window/Level based on a region 

 Window/Level for multiple images 

 Apply color LUT 

About Window/Level 
Window/level refers to a special form of contrast and brightness adjustment that 
is routinely applied to medical images.  A more precise term is Window Width 
and Window Level adjustment. 

Use Window/Level to adjust the brightness and contrast of an acquired image. 
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Adjusting the Window/Level for a single image 
To adjust the Window/Level (W/L):  

1. From the Tools menu, select Window/Level Image. 

OR Click the Window/Level Image button  on the toolbar. 

2. To adjust the window and level, you can use the mouse or the arrow keys. 

 To change the level: 
 Move the mouse up and down. 

OR 
 Use the up and down arrow keys. 

 To change the window width: 
 Move the mouse left and right 

OR 
 Use the left and right arrow keys. 

3. To select additional options, right-click the image. 

4. From the shortcut menu, select one of the Window/Level options: 

 Apply last W/L to this image. 

 Auto W/L this image. 

Note:  Each modality may have specific options on the shortcut menu, depending 
on the configuration set for your facility. 

Mouse shortcuts and accelerators for window/level 

 

Select  and move To ... 

mouse up decrease level 

mouse down increase level 

mouse left decrease window width 

mouse right increase window width 

Ctrl + mouse up decrease level x 10 

Ctrl + mouse down increase level x 10 

Ctrl + mouse left decrease window width x 10 

Ctrl + mouse right increase window width x 10 

Shift + mouse up decrease level x 20 

Shift + mouse down increase level x 20 

Shift + mouse left decrease window width x 20 

Shift + mouse right increase window width x 20 
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Keyboard shortcuts and accelerators for window/level 

 

Select  and press To ... 

up arrow decrease level 

down arrow increase level 

left arrow decrease window width 

right arrow increase window width 

Ctrl + up arrow decrease level x 50 

Ctrl + down arrow increase level x 50 

Ctrl + left arrow decrease window width x 50 

Ctrl + right arrow increase window width x 50 

Shift + up arrow decrease level x 100 

Shift + down arrow increase level x 100 

Shift + left arrow decrease window width x 100 

Shift + right arrow increase window width x 100 

Note:  The Shift control used with the arrow keys, which accelerates the motion 
100 times, is useful for adjusting the Window/Level on very large images such as 
CR (computed radiography) and DX (digital x-ray). 

Adjusting the Window/Level automatically based on a region 
To adjust the Window/Level (W/L):  

1. From the Tools menu, select Window/Level Image. 

OR Click the Window/Level Image button  on the toolbar. 

2. Right-click the image. 

3. From the shortcut menu, select one of the following options: 

 Apply Auto W/L to region. 
 The cursor changes to: 

 
 Drag the cursor to draw a box around the region of interest. 

 
This system automatically window/levels the entire image based on 
the contents of the box that you draw. 

 Apply Auto W/L to following series images. 
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Adjusting the Window/Level for multiple images 
To adjust the Window/Level (W/L) for multiple images: 

1. From the Tools menu, select Window/Level Image. 

OR Click the Window/Level Image button  on the toolbar. 

2. To adjust the window and level, you can use the mouse or the arrow keys. 

 To change the level: 
 Move the mouse up and down. 

OR 
 Use the up and down arrow keys. 

 To change the window width: 
 Move the mouse left and right 

OR 
 Use the left and right arrow keys. 

3. Right-click the image. 

4. From the shortcut menu, select one of the Window/Level options: 

 Apply last W/L to all series images. 

 Apply last W/L to following series images. 

 Apply Auto W/L to entire exam. 
The system automatically window/levels every medical image in the 
exam.  Montage images are skipped. 

 Apply Auto W/L to following series images. 

Note:  Each modality may have specific options on the shortcut menu, depending 
on the configuration set for your facility. 

Keyboard shortcut for all images in series 

You can use the following keyboard shortcuts for the Window/Level tool: 
 

Shortcut Tool  Action 

> or . 

 

Window/Level Mode to apply action to all images in the 
series.  After you apply the shortcut, the 
cursor displays an "A" (for All). 

Caution when using the > key, Apply to Whole Series 

When using the > shortcut or the View menu option Apply to Whole Series to 
apply the imaging tool to all images in the series, you may affect images that are 
not currently visible on the display. 
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Using color LUT 

About color LUT 

The LUT stands for "Lookup table." A color LUT creates a color map - an 
artificial mapping of a grayscale image to arbitrary color values. 

Patient Safety Warning when using Color LUT 

Some color lookup tables (LUTs) emphasize aspects of diagnostic interest to the 
viewer by mapping particular grayscale values to certain meaningful color, such 
as red. 
 
The Window/Level tool allows you to adjust grayscale contrast and brightness 
values.  These modified grayscale values are colorized by the color LUT. 

Potential problems with adjusting grayscale contrast and brightness 

Adjusting grayscale contrast and brightness could result in: 

 Misleading (false positive) color mapping with regard to the size and 
extent of pathology. 

 Misleading (false negative) color mapping with regard to the presence or 
absence of pathology. 

Potential problems with lossy compression of these images 

Using lossy compression on images with adjusted grayscale contrast and 
brightness could result in: 

 Changes to the Color Mapping characteristics of an image. This could be 
diagnostically significant. 

Applying color LUT 

Note:  The system does not save color LUT settings.  Subsequent viewing of the 
image will not display any color LUT. 

To apply color LUT:  

1. From the Tools menu, select Window/Level Image. 

OR Click the Window/Level Image button  on the toolbar. 

2. Right-click and select a color LUT option from the shortcut menu. 
 
Examples of color LUT options include:  

 Cool LUT. 

 Warm LUT. 

 Thermal LUT. 
 
Note:  The color LUT options on the Window/Level shortcut menu may 
vary, depending on the specific configuration settings for your facility. 
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3. After you select a color LUT and a window-level setting, you can apply these 
settings to: 

 All images in the same series.  From the shortcut menu, select Apply last 
LUT to all series images. 

 All images in the following series.  From the shortcut menu, select 
Apply last LUT to following series images. 

Enhancing Contrast Using Image Processing  
 About image processing 

 Applying image processing 

 Using keyboard shortcuts 

About Image Processing 
Image Processing makes fine details in low-contrast images stand out clearly by 
applying a two-dimensional Unsharp Mask to the image. This process works by 
subtracting from the original image an Unsharp Mask created by blurring or 
smoothing a copy of the original image. As a result, features that are smooth and 
have large scale structures are suppressed in favor of features with fine 
structures.  

The degree of fine detail enhancement can be adjusted with pre-selected 
parameters for the detail and contrast or you can create custom parameters. 

 The Detail parameter affects the kernel size over which the Unsharp 
Mask is computed; larger values result in enhancement of larger 
structures in the image. 

 The Contrast parameter controls the amount of gray scale enhancement 
applied; large numbers result in greater contrast enhancement.  

Applying Image Processing 
To apply Image Processing:  

1. Click the Apply Image Processing button . 

2. Right-click the image.  

3. From the shortcut menu, select one of the image processing options:  

 Apply Edge Enhancement–Low. 

 Apply Edge Enhancement–Medium.  

 Apply Edge Enhancement–High.  

 Apply Edge Enhancement–Custom.  

 Apply Image Processing to all series images.  

 Custom Edge Enhancement Settings.  

 Cancel Image Processing. 
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Using keyboard shortcuts 
You can use the following keyboard shortcuts for the Image Processing tool: 
 

Shortcut Tool  Action 

> or . 

 

Image 
processing 

Mode to apply action to all images in the series. 
 After you apply the shortcut, the cursor displays 
an "A" (for All). 

Caution when using the > key, Apply to Whole Series 

When using the > shortcut to apply the imaging tool to all images in the series, 
you may affect images that are not currently visible on the display. 

 


